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Publishable executive summary

This guide aims to establish a set of general recommendations and rules that BIM modellers and companies
can implement to ensure that a proper workflow is made for renovation projects. Depending on the
considered BIM Use case, the modeller will adopt certain techniques to ensure the model is adequately
made for the chosen use case and to avoid over/under-modelling. The document will refer to two main 3D
modelling software applications; REVIT and ARCHICAD. The proposed guidelines highlight what are the
practical steps to take when modelling using these two applications and guarantee that the model is in
accordance with the BIM Use Case selected.

The general rules have a broader view over the BIM modelling in relation to the items that a user might
face while working on projects. This can be for example risks of switching from older to a newer version of
the software, the importance and requirements of a project template, the necessity of setting coordinates
of the project, creating levels, and adopting the correct level of development of the model, how to manage
the model, as well as splitting a BIM model and making a proper export of IFC and other formats.

Since renovation projects require a lot of data collection and BIM Models are built based on the collected
data, chapter 2 is focused on how to build such a model considering the main important sources of
information: point clouds, 2D drawings, images, PDF files, etc..

Planning renovation projects are different from new buildings because of the uncertainty, ambiguity of the
information from a BIM models perspective since they require to include a lot of initial data as well as the
result (building after renovation). Structuring the information, creating special parameters to show data in
the BIM Model, presenting several ways of modelling by introducing “modelling phases”, and having a

different level of development in the same model are some specific items tackled in this document.
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Definitions

3D Mesh: Is a collection of vertices, edges, and faces that define the shape of a Polyhedral (three-
dimensional shape with flat polygon faces, straight edges, and sharp corners).

BIM: Use of shared digital representation of a built asset to facilitate design, construction, and operation
processes to form a reliable basis for decisions®.

CDE: Agreed source of information for any given project or asset for collecting, managing, and
disseminating each information container through a managed process2

Closed BIM: Is a BIM environment where all the stakeholders use the same software and the same version
of a BIM authority tool.

Design phase: A phase is a part of the services an AECO design company can offer for a building project.
Photogrammetry: The technology of acquiring reliable information about physical objects and the
environment through processes of recording, measuring, and interpreting photographic images and
patterns of recorded radiant electromagnetic energy and other phenomena.

Modelling phases: Most used BIM Application, allow to include a modeling timeline that may be
correspondent to the timeline of the project (but not necessary, since one may want to group more
construction phases into one modeling phase). Modelling phases can highlight how the building will
develop over time, including as is situation, what will be demolished and what will be new constructed.
Open BIM: Is a working approach where stakeholders can share their data with any compatible software
using vendor-neutral data formats.

RIBA stage: Defines the broad outcomes and strategic aims for a stage in the building process. A RIBA
stage does not contain detail tasks and it is addressed to both client and project team to better
understand what the goals for each step in the process are. The stages are part of the RIBA Plan of Work.
Workset: This term is specific to REVIT software and refers to a collection of 3D objects in a workshare

project®.

1 Definition according to 1ISO 19650-1/2018 Organization and digitization of information about buildings and civil
engineering works, including building information modelling (BIM)- Information management using building
information modeling — Part 1. Concepts and principles

2 Definition according to 1ISO 19650-1/2018 Organization and digitization of information about buildings and civil
engineering works, including building information modelling (BIM)- Information management using building

information modeling — Part 1. Concepts and principles >
3 https://knowledge.autodesk.com/support/revit-products/learn-explore/caas/CloudHelp/cloudhelp/2019/ENU/Revit- Ve
Collaborate/files/GUID-86810293-6510-4F5A-8009-27B4767CA136-htm.html
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1. INTRODUCTION

The goal of the document is to describe the practical steps and requirements for BIM modelling in the
context of the BIM SPEED project. Currently, the vast majority of BIM projects refer to newly designed
buildings, and the guidelines available are related to this type of project. Renovation projects and the
purpose of the BIM model must be approached differently than “new building” projects since the base of
information is different. In contrast to the new-building sector, where information is generated
progressively throughout the design process, working on existing buildings requires gathering information
from various sources to depict as-built conditions. Stakeholders in the AEC industry that are designing new
buildings in a BIM environment have already implemented workflows that are tested, reliable, and stable.
This guideline is aimed and targeted specifically at that part of the AEC industry responsible for creating a
BIM model, namely BIM modellers, BIM coordinators, and BIM managers regardless of their experience with
BIM. The BIM Speed consortium has defined several BIM Use cases that are relevant for residential
renovation projects to assist stakeholders in defining the information required for their specific renovation
project. In Deliverable 1.1, the BIM Speed Methodology Toolkit was established, and the BIM Use cases were
presented along with the associated business process and methods to accomplish the BIM Use Case. In
Appendix 1, a glance at the toolkit is shown.

This document is oriented towards demonstrating the best practices and proposing specific
recommendations in creating a BIM model in direct correlation with the BIM Use cases proposed. For a
better understanding of how to apply the proposed principles, the authors described and detailed the
principles for the two most well-known BIM authoring tools available on the market for creating BIM
models. The principles can then be transposed to other BIM modeling software applications, and so they
are not restrictive in this sense. This document will address the various sources of as-built information as
well as their utilization in reconstructing a BIM model. Most often it is needed to share the BIM model with
other stakeholders working on different disciplines to perform various BIM Use cases even when they use
different software applications (for example energy analysis that cannot be done with the modelling tool).
The standardized file to exchange the models between different stakeholders is the .ifc type, but the parties
involved in a project can exchange files using other formats. The two authoring tools are only used as a
means to describe and exemplify but the document is not emphasizing that these are the only two software
to use. Principles can be applied to other software, but the different settings in so many software in the

market make it impossible to address all.
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2. General rules for project setup and BIM model

creation

Proper creation of a BIM model translates into time-saving for the whole project and cost savings for the
design company and the other relevant parties. This chapter refers to general requirements to create a BIM
model taking into consideration the demands and specifications of the renovation project.

This section is aimed at highlighting the main requirements in creating a project template and
understanding the specifics related to MEP project templates. It will describe the main units to use in a
project, the need to set up the model on the coordinates and the ways to acquire them, and the definition
and specification of the grids. Additionally, the chapter offers a short description of the level of
development, how to create proper 3D objects to be used in renovation projects, what are the modelling
phases, and how to manage the BIM model when a breakdown into separate models is required. Key points
on responsibility and data ownership and different versioning of the BIM tool are also highlighted.

In the end, the chapter will showcase the necessary steps to successfully export ifc files from the two

mentioned authoring tools.

21  BIM Model Project template

Having a BIM model project template (hereafter referred to as a project template) helps to create a certain
standard when modelling. The aim is to ensure consistency across all the designers on the project in terms
of information flow during the project regardless of the number of users.

Additionally, a project template ensures that repetitive and tedious work is reduced to a minimum. Tasks
such as creating title blocks, exporting settings, styling, adding company parameters used across all projects
(name, address of the company, logo, etc), scheduling, and setting of the project units, should all be done
once in the project template. All these activities performed in a project template, which is done only one
time, will ensure that a significant amount of time is saved.

Project templates are different from one company to another. Commonly, the project template is created
by the BIM coordinator or BIM lead in the company (for roles description see Appendix 3). Best templates
are usually created by the BIM coordinator with the active involvement of the BIM designers team. There
are the main actors in creating a BIM model, so their perspectives and feedback should be highly
considered.

For projects where multiple companies are involved, each with their template, a common ground should
be established, and the templates should be discussed in a BIM kick-off meeting so that information is
shown consistently on all the models. Thus, the project templates should give a certain degree of flexibility.
The project template should have all the settings expressed in the following subchapters. views and MVD
(a set of IFC parameters setup to be exported based on the further usage of the IFC file) are created so that
the exported file will be done fast, without any errors and the intervention of other designers. The

MVDs are linked to the BIM Use cases for which the model will be created. Most used MVDs refer

Yo
to coordination, analysis (e.g., for structural or energy analysis), or quantity take-off, however, 6* c:‘\‘
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specific MVDs can be made depending on the specific needs of a project (e.g. to export only the facades for
a specific contractor).

For each type of export, a view should be created and presented in the project template. Every template

should have a detailed guideline prepared for the designers to read. This guide will make it easier for new

people joining the project to get accustomed to the principles by which the BIM models are created within

a company.
Project templates should be different for new projects and renovation projects. Each of these types has
different workflows and different types of required information. For example, in a renovation project

designers will need to show what elements will be demolished and which elements will be kept as in

existing conditions (Figure 1).

1)

E

i

S e

=

il i) ! i i

Figure 1. Blue wall is an existing wall that is marked for demolition. The walls with white are new.

The naming convention is one aspect that must be considered when creating a template. Since the template
may contain some of the most used families, it is recommended to name them according to a BIM standard
(e.g, NL-SfB standard) or the company standard. If the software allows, create a view of the described
naming convention so modellers can refer to it during the naming phase, thus minimizing the risk of
potential errors. Naming convention not only refers to 3D objects, but also the views created inside the
model, schedules, rooms, levels and grids, and all other parts of the project documentation including the

name of the BIM model file. The naming convention is described in the BEP.

MEP project template
MEP BIM project templates (Figure 2) have some particularities that differ from a project template for an

Architectural BIM template or Structure BIM template. First of all, MEP has multiple

s
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subdisciplines. Depending on the size of the project, the MEP model can be a single file or multiple files
(see 2.6), i.e,, one file for each subdiscipline (e.g., Electrical BIM model).

It is recommended to start with an MEP template that covers all the subdisciplines and then split the
template into subdisciplines and remove what is not necessary for that specific subdisciplines. Acting in this
manner will ensure consistency between the subdisciplines in terms of text styles, line styles, title blocks, to

name only a few.

Electrical template (colours, filters, cable dimensions, cable tray dimensions,
cable types, electrical units, power loads, etc.)

HVAC (colours, filters, fluids, pipe types, duct types, routing types, defining
the types of systems, calculation method etc.)

Plumbing and water (colours, filters, fluids, pipe types, routing types, defining
the types of systems, calculation method, etc.)

MEP Template

Figure 2. Example of items that an MEP template should contain, based on subdiscipline. Software Revit.

Residential buildings do not have so many types of installations as office buildings. Nevertheless, it is
important to have all the MEP systems defined in the template, at the start of creation. Based on engineering
requirements when the work starts, unused systems can be removed from the template if it is considered
that this will increase the size of the model. Besides the name of the system used inside a building, the
temperature of the fluid circulating through the system should be considered when creating a new MEP
system in the template. A comprehensive list is as follows:

o heating radiators: supply and return.

o heating floor: supply and return.

o heating district: supply and return.

o cooling split system: supply and return.

o cooling network: supply and return.

e potable water system.

e Sewage system.

o Rainwater system.

o Greywater system.
L . Ve
« Ventilation - fresh air. C-
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o Ventilation — supply air.
o Ventilation - return air.
o Ventilation — exhaust air.
e Natural gas.
It is recommended to set up all the types of piping used In an MEP template according to the material,
diameter, fluid circulating inside the pipe, and proper fittings. As an example, a project template will contain
copper, steel, polypropylene, polyethene, and PVC pipes. Polypropylene pipes can be for water distribution,
heating systems, or cooling systems, each with a different colour and different specifications. The same
setup must be done for ducts and electrical systems.
The colouring of any MEP system should be done in the template. MEP systems are coloured in 2D and 3D
according to international standards or national standards. A few widely used colours are the following:
e Heating: supply —red
e Heating: return — blue
e Gas pipe - yellow
o Sewage - brown (usually)
o Potable water - blue
o Domestic hot water - red
e Ventilation —supply - green
o Ventilation —return - blue
Not all BIM modelling tools allow the possibility to model MEP elements. Since the number of settings and
customizations needed for an MEP model are more than for a structure model, choosing an appropriate
software application is important. Depending on the strategy of every company, one may choose only one
single software application that can cover all three disciplines or different software applications for each

discipline.

2.2  Coordinates and units

Project units and setting the coordinates of the model are very important for further project coordination
and clash detection. When combining multiple models into one central model, all the models must be in
the correct place with respect to each other (e.g, the structural slabs to be above the architectural floor).
Arranging the models into the correct place can be done afterward, but it is not advised since it can lead to
errors and time-consuming process of revising. For this reason, it is highly recommended to set the units in
a project template. As such, setting the units should be part of the project template. If project specifications
require to work in different units than the company’s standard, then this activity should be done at the
beginning of the project. The units for the model are specified in the BEP. The following units should be
defined:

Common units:

e Length: m (2 decimal)
e Area:m2 (2 decimal)

: - Yo
o Volume: m3 (3 decimal) S
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o Angle: degree (3 decimal)

MEP units:

o Density: kg/m3 e Ductsize:mm

e  Friction: Pa/m e Cooling/ heating load: W
o Power: kW e Current: A

e Power density: W/m2 e Frequency: Hz

e Pressure: Pa e Conduit size:mm

e Temperature: Celsius e Pipe density: kg/m3

e Velocity: m/s e Pipesize:m

e Air/ pipe flow: L/s

Working in a BIM environment requires having the model placed on the correct and real-world coordinates.
The coordinates are dependable by the country’s own reference coordinates system and must be provided
by the BEP. When working with multiple models, the coordinates must be placed correctly in one model
(either in a master model or in an architectural model). From that master 3D model, the coordinate will be
transferred to the rest of the models.

Coordinates are obtained via the topographic surveys. Most commonly, coordinates are stored in an Excel
file or a civil .dwg file. In Table 1, for the most commonly used software tools, general workflows on setting

up the coordinates are given:

Table 1. Setting up coordinates

Software Setting the coordinates inside a model

REVIT Based on a .dwg file, .csv or .txt files, coordinates can be acquired in the model.
Coordinates can be stored in a Master 3D model or, commonly in the
Architectural 3D model. Other models will acquire their coordinates from the

previously mentioned model.

ARCHICAD Use the Coordinates Pallet and choose the appropriate type of coordinates

according to country.

2.3  Level and grid definition
Defining the levels (or floors) and grids are an important activity and should be performed at the start of
the BIM modelling. Considering this is a renovation project, the information comes from the existing 2D
drawings or a point cloud if available. If one must add new levels needed during the design process, then it
is advised to add them from the start as much as possible (e.g., adding a new ceiling level). Adding new
levels while in an advanced stage of modeling can result in spending more hours than estimated.
The name of the level should be easily identifiable and as short as possible. The name and the

graphic representation of the levels should be part of the template. The name of the levels is part
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of the naming convention and should be found in the BEP. Depending on the size of the project (2.6) the
levels and grids are created in a master model or directly in the Architecture model. The level should be

defined above the structural part of the floor and below the finishing. (Figure 3).
——— Floor finish level line

—— Level line

/ Structural floor

Figure 3. Defining the level ofé building (picture from Revit software)

Levels can be found under different names, depending on the BIM tools used. For exemplification, we will

refer to the BIM tools mentioned in the Introduction chapter.

e Since REVIT works with work-sets, the levels and grids must be assigned to a work-set. The most
recommended approach is to use the default work-set “Shared levels and grids”. Simply create a
section view and start creating the levels using the “Level” command from the Architecture tab.
Structure and MEP modellers can use the “copy/monitor” command to create the levels from the
architectural model (see Figure 4). To remove the graphical duplication of the levels or grids, one

must go to “Manage links” -> select a link -> Manage work-sets -> close the work-set -> Ok.

‘8'53‘58'+E»® 18-Level 1 18-Level 1 @Jf&%ﬁ";‘fe' !
445 445

Figure 4. Doubling the levels after Copy/Monitor.

e In ArchiCAD, one should use go to Design -> Story settings. This will allow users to create, delete, or

rename stories. (Figure 5)
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Figure 5. ArchiCAD defining levels.*

2.4  Level of development

The release of ISO 19650-1 introduces the terms of “Level of Information” with the scope of introducing only

one concept that all stakeholders need to adopt and understand, adding more clarity to the terminology

used by each member when discussing BIM. As it is specified in ISO 19650-1, the level of information

required is “the quality of each piece of information to be provided in terms of granularity so that it serves

the purpose for which this information is required and no more”.

Unfortunately, one concept was not fully defined and explained and that is the Level of Information. The

term Level of Development is still very used and most countries try to define it around 1SO 19650.

Level of development (LOD) comprises of three levels, and it is about graphical and data aspects related to

the 3D objects presented in a BIM model:

o Level of Geometry — from a geometrical and graphical perspective, it is the level of detail included in
3D elements

o Level of Information — of the 3D elements, referring to specifications, performances, and all the data
that is contained in a 3D element. Also known as the level of detail (LOD).

o Level of documentation — the connection between external files and 3D elements.

The level of development should be defined or strictly associated with a project phase. This will prevent

over-modelling for different stages throughout the project. Some recommendations can be followed to

frame a BIM map, based on RIBA project phases and the graphical view of the 3D object:

o LOD 100 - RIBA stage: Preparation and brief — In the case of MEP, LOD 100 signifies schematic design.
In a BIM model, large equipment or entire technical areas will be represented as a volume

reservation. (See Figure 6)

* https://helpcenter.graphisoft.com/user-guide/76759/
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e LOD 200 - RIBA stage: Concept Design — for the MEP model, generic 3D objects are modelled. The
characteristics are related to approximate size, shape, location, and orientation. Maintenance space is
presented (see Figure 7)

o LOD 300 - RIBA stage: Developed Design — 3D objects for MEP at this LOD will mean that they will
have the exact number of items to be used, exact shape and volume, and non-graphic information
such as airflow, heat output (Figure 8).

o LOD 400 - RIBA stage: Technical design and construction — the 3D objects are accurate. Elements are
defined as they will be built, containing all necessary parameters for procurement, assembly, and
commissioning,

o LOD 500 - RIBA stage: Operate and Maintain, Construction Handout. — Model elements are field
verified, functional representation of the asset in terms of size, shape, location, quantity, and

orientation. The accuracy of the information attached to objects is more relevant.

MEP technical space

Figure 6. MEP represented at LOD 100

o\.

. .

Figure 7. Ventilation and heating. LOD 200. ‘b‘
“‘\
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Figure 8. Ventilation and heating LOD 300

Figure 9. Ventilation ad heating. LOD 400

241 Level of Geometry
The modeler or designer must take into account the connections between structural and architectural when
modelling. The geometry itself must provide exact quantities for quantity take-off for a given design phase
or BIM Use Case. The way of modelling should tightly correspond with the rules of measurement of specific
building categories defined at the outset of the project. This will enable the quantity surveyor to perform
accurate quantity take-off from the model.
The typical rules of modelling might be:
o Modelling structure walls and columns from top slab to bottom slab (in-between two slabs).

e Beams, walls, and columns geometry should be cut out by slabs.

o There should be one solid geometry per structure element. >
“
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o Elements should be modelled on a specific level — elements should be divided by level. This is valid
for MEP elements also.

Both rules of measurement and modelling guidelines should be described in the BIM Execution Plan.

242 Level of information
Every single model element needs to be given proper classification from the chosen classification system
in the projects. If the official classification system is not chosen in the project, custom classification needs
to be added to the element’s parameters. The purpose of classifying model elements is to state what the
elements are and what function they will perform in the building.
As soon as elements have a classification, the designer can add matching properties to model elements.
The properties and property sets need to be associated with classification items and can differ per project
stage, as described in the BIM Execution Plan (Figure 10).
For instance, one can classify structural columns as Ss_20_30_75_15 - Concrete column systems according
to Uniclass 2015. Three proprieties will be defined for Ss_20_30_75_15 - Concrete column systems item as

stated in the BEP.

Figure 10. IFC Model - Elements modelled according to rules of measurement and coloured by a classification system

2.5 3D objects & libraries

As explained earlier, every 3D model is comprised of 3D elements, at different LOD levels, and 2D elements
(grids, text, annotations, level line, etc.). The accuracy of a 3D model comprised also of correct classification
of the objects. Software used for BIM modeling have certain categories to classify each object in a model
such as columns, walls, floors, ducts, pipes, electrical equipment, mechanical equipment, etc. A key pointin
having clarity in the model is to always use the correct categories for the correct item intended to be

modelled. As an example, a round duct should never be used to represent a pipe, or a cable tray

to represent an existing duct.
-
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3D objects created by one specific BIM tool cannot be used directly by another BIM modelling tool. BIM
objects created with a certain authoring tool have a certain extension (.rfa from Revit, .pln from ArchiCAD,
etc.) that cannot be read by other software applications. Using an open BIM environment will reduce the
risk of interoperability issues.
BIM authority tools have predefined libraries that come together with the software. These libraries have all
the basic elements to start modelling, e.g., walls, columns, pipes, ducts, valves, floors, etc. Every company
can develop its specific library for renovation or new building projects (e.g., Family editor in REVIT or Library
Part Maker for ArchiCAD) starting from those default libraries. Free-form objects can be made using either
embedded tools in the BIM modelling software or using add-ins (e.g., Dynamo for REVIT, Grasshopper for
ARCHICAD)".
There are also online libraries such as bimobject.com, mepcontent.eu, nationalbimlibrary.com, bimstore.co
from where BIM modellers can use 3D objects. However, these objects should be inserted directly ina model
in compliance with the internal guidelines of the company but not without a BIM coordinator to revise them.
Below there are some criteria that a BIM object should fulfil.
Important 3D objects that most users frequently forget to define in their libraries are represented by
openings in building elements and placeholders. Openings in 3D objects are important for solving crossing
issues between MEP elements and structural building elements. Placeholders are generic elements that are
used to illustrate the space that will be occupied by one or more objects. Placeholders are directly
connected with the LOD level used. As seen in the previous subchapter, for LOD 100 only a volume is needed
to represent MEP technical areas. That volume constitutes a placeholder. In Figure 6, the box constitutes a
placeholder for that technical space.
Until LOD 300, the same library can be used for new and existing buildings. For LOD 300 and 400, libraries
should be different between these two types of projects, because the items they represent can even be from
different periods. For architectural elements such as walls, floors, doors, and windows, objects can be
created as information on different types of elements can be found in books or guides (e.g., brick walls with
the most common thickness used).
For MEP, this item becomes more complicated since equipment and valves can be completely different (e.g.
manufacturers are off the market) or pipes can have materials that in the present are not used (e.g., lead
for sewage). Pipe types and systems can be easily created since the information may be easier to find, but
for the rest of the elements that are part of an MEP system, the library will be developed in time. BIM object
libraries should be kept, either on a local server or on a shared platform. It is recommended to be kept on
an online platform, such as SharePoint or BIM-SPEED Platform.
Before using any 3D object inside a project that is not included in a verified library, it should be tested.
Below, is a fast checklist to be considered when checking a 3D object:

o compliance with the naming convention.

® Grasshopper can be used also for REVIT by using a package for Dynamo. Please visit

-
https://primer.dynamobim.org/ for more information about Dynamo. -

BIM-SPEED D2.4 Guidelines for as-built BIM modelling of existing buildings

page 20 - 55


https://primer.dynamobim.org/

BlM““:‘\ SPEED
)
o correct assignment of parameters (especially for MEP elements).
o depending on LOD, the 3D object has the correct dimensions and information.
o presence of a thumbnail. This is important so that picking a family from a library is much easier. It
allows one to visualize the family before loading it.
o if materials are shown correctly.
o thesize of the file of the 3D object.
o if the family is parametric, test to see if it is working as it was planned (change several dimensions,
with up and down values)
o REVIT specific: if the family is hosted, check to see if it's adjusting to thickness
In the following subchapters, users will be able to distinguish between how two BIM authoring tools tackle
3D object creation.
REVIT 3D objects
For REVIT, 3D objects are named “families” and can be saved separately in a native file format (.rfa). There
are 3 kinds of families in REVIT.

1. System families: walls, roofs, floors, ducts, pipes, cable trays. These are elements that a contractor
will assemble on site. System families are preloaded into REVIT, they cannot be loaded for
somewhere else, nor can they be saved to a library. More information can be found here.

2. Loadable families: these objects can be created, saved, and loaded from and to a library. For better
performance, the files should not exceed 1 Mb per file. The number of parameters does not
influence the size of the family. Loadable families are used to creating the following: More
information can be found here.

o Building elements that can be purchased, delivered and installed such as windows,
doors, furniture, etc.

o MEP elements that can be purchased, delivered and installed such as boilers, plumbing
fixtures, air handling units, sprinklers, etc.

o Annotation elements as 2D symbols, title blocks.

3. In-place families are unique elements that are created for a specific project.

They can be transferred from one project to another, however, consequently, the size of the file
will increase rapidly, and thus there will be consequences on the performance. Therefore, it is
recommended to limit the use of such elements. More information can be found here.
In REVIT, all families are referenced to the level where they were created. Some families can be hosted or
not. A hosted family is a 3D object that needs a building element (host) so that it can be placed in the model.
The most common hosts are walls, ceilings, floors, etc. Once a family is created as hosted, there is no process
to make it non-hosted. The only solution is to create it from scratch.
For MEP designers hosted families are not preferred as they do not work across linked models (the MEP
planner rarely works in the same model as the architect), and a wall-hosted family cannot be

placed in the MEP model since the host is not in that model. Another big disadvantage is that if
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the host is deleted the corresponding hosted element(s) are also deleted. This situation can lead to
coordination issues.
A compromise is to use face-based families. These families look for a “face” of an element (not necessarily
need to be a wall or a ceiling). The advantage here is that these families detect and orient to the faces of
an element and work across linked models. Face-based families have two important parameters: “default
elevation” (definition of the height the element is placed at) and “maintain annotation orientation” (force
nested annotation symbols to display correctly). Furthermore, the hosting information of a face-based
family is tied to the element ID of the host. To move the family with the hosting element, the hosting
element must be moved—it cannot be deleted and recreated. These types of families are recommended
for modelling existing elements since the position is fixed.

Another option is non-hosted families, which only refer to the level on which they are placed. They will not

adjust to the orientation of the host element but can be placed anywhere and their rotation can be adjusted

manually. To facilitate this process, rotation parameters can be introduced to make this process slightly
easier. Non-hosted families can be copied very easily and can also be grouped. Non-hosted families are
recommended for modelling the new installations since their position can be changed in the design process.

The most common practice, which is highly recommended, is to distinguish between face-based families

and non-hosted families by naming them accordingly. For face-based families, the abbreviation “FB” can be

used in the naming of the 3D object file. For non-hosted, the “UN” abbreviation is commonly used.

REVIT families, besides their geometry, have data attached to them. For data to be stored in a family, REVIT

created parameters where a user can fill them in to define the objects' proprieties (a few examples: length,

width, height, airflow, power, material, etc)). In REVIT, there are multiple types of parameters that are
handled differently and shown differently:

o Family Parameter: this is a parameter that exists only in the Family and cannot be scheduled (place
into a REVIT table). Users can see it and fill the data inside it and can be variable, for example, height,
material, width.

o Shared Parameter: this is a parameter that can be used in multiple families and multiple projects.
They are stored in a separate file (a .txt file). These kinds of parameters can be put in a table or create
tags (a label used in REVIT for showing some information about that object in a 2D view) for them.

o Project Parameters are parameters that are used in one project. One can add project parameters to
multiple families (or categories) at once. These parameters appear in schedules but not in tags.

o Global Parameters are similar to project parameters with one difference, mainly that these
parameters cannot be assigned to family categories.

Regarding the parameters inside the families:

o Take advantage of default parameters (such as description, manufacturer, cost, etc). One must be
careful of family parameters. This kind of parameter in Revit cannot be scheduled.

e One should create a new parameter only if no default REVIT parameter can be used to

express correctly the information intended to be placed. For example, for a socket, BIM
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designers may need to display its “use”. This will imply creating a new parameter called “function”
because this parameter is not included by default in REVIT.

o All parameters used by a company should be stored in the “Shared Parameters” file.

o Parameters must be created based on their use for fulfilling a certain BIM USE CASE. It is
recommended to either have them in different “Shared Parameters” files or the same file but divided
into groups.

252 ArchiCAD 3D objects

ArchiCAD comes with a standard object library that covers most of the building elements. The native file

for 3D objects of the tool is .pln. The 3D objects are parametric by default. The parameters from one object

can be transferred also to another object from the same subtype (for example from one object that
represents a window to another one that represents another type of window).

When a new project is created, the software will load the library contained in the project template. Further

libraries can be added as well. ArchiCAD works with multiple types of libraries, the embedded library, or

linked libraries.

An embedded library is a project-specific library containing the objects that users have created or saved for

a specific project. It is worth mentioning that embedded objects are available only in a particular project

and once an object is deleted they will be gone.

Linked Libraries include the standard ARCHICAD library loaded by default, as well as any other libraries

added by users. In contrast to the objects of the Embedded Library, these libraries are linked folders that

are saved as .lcf or .pla files. Libraries can be stored in a traditional server or in the cloud.

The following approaches are recommended as best practices for setting up Object libraries:

o Upload all company’s libraries to a dedicated BIMcloud/BIM Server. This enables one-step updates
which are then available to all users, including one-user and teamwork project users.

o The Embedded Library should serve as a project library, containing project-specific objects that are
always available and editable, and saved with the project.

o Any project-specific object that is modified frequently should be placed in the Embedded Library.

o Only those objects that are project-specific should be embedded. For better performance, it is
recommended to keep the size of the Embedded library low.

o If users want to use a custom object in several projects, it is recommended to place it into a company
Library stored on a BIMcloud/BIM Server that is accessible to all users, rather than save it to an
Embedded Library.

e When one must archive a project, it must be saved in the PLA file format.

e Itis NOT recommended to save all objects in the Embedded Library.

The characteristics above also apply to the MEP library, which is divided into logical folders such as

ductwork, pipework, electrical, etc. Most common MEP systems are available by default, but users are able

to create new ones or rename the existing ones.
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The data for 3D objects in ArchiCAD are also inserted using parameters similar to REVIT. The software
provides default parameters. ArchiCAD allows the creation of user-defined parameters, the only difference
from REVIT is that they are called “proprieties”. Users can create as many as they want according to the
needs of the project. The proprieties can also be scheduled similarly to ArchiCAD parameters.
3D Object Classification
Regardless of the BIM software used, 3D objects in a BIM 3D model need to be classified according to
certain rules that are known to stakeholders. This makes the comprehension of the BIM model much
easier. The file exchange format for Open BIM is IFC. By exporting to IFC, each 3D object will be classified
according to the principles issues by BuildingSmart. However, besides the IFC classification, other
standards? are largely used in conjunction with IFC classification in the model. The BIM authoring
software allows users to import classification codes such as Omniclass (for the U.S.) or Uniclass 2015 (for

the U.K. and in Europe) and add the classification complementary to the IFC one.

2.6 Modelling phases and model management
BIM modelling in a renovation project will most likely involve the modelling of phases. Modelling phases
can be defined as the state of the BIM model of a building at a certain milestone in the project. The easiest
setup of a BIM model includes 3 modelling phases:

e Existing phase — the existing building is modelled as it is, and all its elements are assigned to this

phase.
e Demolition phase - the existing elements proposed to be demolished will be assigned to this
phase. The elements are the same ones modelled in the existing phase.

e New phase — new elements added to the building will be included in this phase.
Specifying the modelling phase of an element requires setting visible graphics overrides or filters in the
model. These graphic overrides will be necessary for a 3D view but also 2D if the project requires exporting
2D drawings. Changing line weights and/or colour will help with the identification of the phases assigned
to the 3D objects. All the graphic overrides can be stored in view templates.
Depending on the BIM authoring tool, a certain graphic hierarchy can be in place. As an example, REVIT has
a visual graphic hierarchy, and modelling phase overrides are least powerful than filter overrides (Figure
11Additionally, REVIT does not allow filtering based on the modelling phase. The most common workflow
to filter elements is by using REVIT work-sets. Every discipline model will have an “Existing” work-set where
all the elements assigned to the “existing” phase will be placed. A similar workflow can be applied to other
disciplines.
Another workflow for filtering elements can be achieved by creating a shared parameter called “Installation

date”. A shared parameter can help the BIM designer to find a certain element based on its parameters.
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2.7  Model breakdown strategy and work-sharing (CIVIL, INFRA, MEP)

Having a working station that fulfills the minimum requirements of the BIM modelling tools is very
important. Even though the workstation fulfils the recommended requirements of the BIM tools used,
sometimes the BIM model may still be lagging. To name a few characteristics that describe a BIM model as
lagging is the slow graphic performances (e.g. rotating a 3D view takes a couple of seconds or even a
minute) or freezing when saving. The reasons can be that several disciplines are represented in one BIM
model, the large sizes of the 3D objects in the model as well as the LOD of the 3D objects. These can
influence greatly the handling of a 3D model making it hard for the BIM modeller to perform tasks. Deleting
unnecessary items in the model is usually the simplest way to reduce file size. One can use the “Purge”
command only to see what 3D objects can be removed but “purge all unused elements” should not be used
at once. Purging all elements should be done before the BIM model is delivered to the client in the final
version.

If deleting unnecessary items in the model does not improve the performance then splitting the model into
subdisciplines is a commonly used solution. Tests made by various companies and BIM designers showed
that it is recommended to keep the project file size under 200 Mb.

One way to split a model is by disciplines such as Architecture, Structural, Electrical, and HVAC. If the
building is very large, one can split even more by placing the facades and furniture in different models
and/or HVAC divided into Plumbing and Water, Heating and Cooling, Ventilation. If exterior networks need
to be modelled, those can also be part of a separate 3D model.

When working with REVIT, it is recommended that each discipline or subdiscipline be modelled on its work-

sets. Working with work-sets allows a much easier split of the BIM model if this is operation is becoming

¢ https://forums.autodesk.com/t5/revit-architecture-forum/phasing-issue-graphic-overrides-not-
changing-all-existing-phases/td-p/9238015
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necessary during the project. For ArchiCAD, a separate file where all layouts are stored can reduce the file

size.

2.8  Data ownership and responsibility

The ownership of the data in the BIM model depends on the project specifics and cannot be generalized.

3D models shall be generated in a manner that allows for other project team members to collaborate

and/or assist, without recourse to complicated instructions.

In every project, a BIM RASCI matrix should be available to ensure every company and BIM role involved in

the project know what they are responsible for. This matrix can be part of or referenced in the BEP. An

example of a BIM RASCI matrix can be seen in Table 2.

Table 2. Example of a BIM RASCI matrix.

Role

Project BIM management
Manage the BIM process.
Has responsibility and power to issue necessary instructions on BIM related issues.

Ensure the creation of suitable project templates as and when required. Update, amend
and issue the BIM Execution Plan (BEP) throughout the lifetime of the project.

Monitor implementation of BIM for consistency and adherence to the BEP and the BIM
Protocol, including regular spot checks and policing of standards adherence.

Assist in the preparation of project outputs, such as data drops.

Ensure that the agreed BIM standards and protocols are continuously communicated to
all BIM Coordinators and are maintained throughout the project and applied to all the
models.

Monitor communication and file sharing to ensure that it is occurring as agreed.
Hosting and attending project design reviews and 3D coordination meetings.
Guide the project team through the BIM process.

Liaise with the project team, client and consultants to review all the models for the project
and initiate any necessary amendments.

(Discipline) BIM Coordination

Combining the federated model, made up of the merger of the different aspect models
of the various disciplines involved in the construction process, using certain protocols,
programs and structures.

Guide a project team through the BIM process.

Hosting and attending project or discipline design reviews and 3D coordination
meetings.

Ensure compliance with the BIM Execution Plan.
Guide a project team through the BIM process.

Regular spot-checking and policing of files to ensure standards are being maintained.

Project
BIM
Manager
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Assisting the Project BIM Manager in coordinating and delivering multi-disciplined data
issues.

Clash detection for discipline and interdisciplinary issues.

Administration of clash resolution.

Enforce the best modelling practices.

Production of digital engineering information.

(Discipline) BIM Modelling C R
Design/construct the project within the BIM environment.

Adding data to the model and generating graphical and (alpha) numeric output.

Making 3D visualizations, derived 2D drafts.

Making drafts, calculations and analyses that are based and/or will be transferred to the
BIM environment.

Ensure compliance with the BIM Execution Plan.

Alert the (Discipline) BIM Coordinator of any issues.

2.9  Consequences of software updates

BIM models are created using modelling tools. Most tools have different versions, which are usually
released each year. The reason for this is to fix bugs reported by users and the release of new features. This
can be an issue that has to be considered as a renovation design project can last for a long period. While
for large companies, this is not a problem in terms of software costs, for SMEs may pose an issue because
they can usually not afford to have multiple versions of the same software at the same time and therefore
are forced to upgrade the models to the newer versions. It is important to know that the version of the
software to be used in a project is to be determined in the BEP. Switching to another version is a decision
that has to be communicated by the BIM Manager to all stakeholders involved, documenting the new
requirements and associated consequences

Upgrading a BIM model is a fairly easy process regardless of the modelling software. However, this process
can entail errors in the new model. The cause of the errors either lies in changes regarding the program'’s
script or changes of functionalities in the newer versions of the software.

The first step, independent of the tool used, is to create a backup version of the current model before
upgrading it. Depending on the tool used, one can just open the file with the newer version and the model
will be upgraded automatically. Alternatively, special tools for example the migration tool for ArchiCAD
can be used.

The workflow for translating a BIM project created in REVIT, from one version to another, is as follows:

1. Create a backup of the model to be upgraded.

2. When working within the collaborative mode, before upgrading, all users must synchronize their
models and close the software. In other cases, the model must be saved and closed. While the
model is upgraded by one user, the rest of the team cannot work on it.

Before upgrading open the model again, using the “Audit” command selected.
4. After auditing the model, save the file in a new location (if it is in a work shared

environment, the models must be detached, before saving them to a new location).
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5. Open thefile in the new version of the software, with the Audit option checked. This is the final step
of the model upgrade

6. |If there are other REVIT files linked to the current project, every single file needs to be upgraded.

Special attention is to be given to the REVIT families throughout the process. Depending on how they were
created, their type, and their complexity, some may get corrupted during the process. If this is the case, one
must delete the corrupted families from the model, upgrade the families separately, and insert them into
the project.

For ArchiCAD, the process is slightly different as there is a specific command:

1. Create abackup of the model.

2. Start the older version of the software and open the model. If it is a Teamwork project, all users
must save their project and close the file.

3. One user needs to start the command “Prepare for migration” and follow the steps indicated in the
dialogue box that appears.

4. After that, the user needs to close the old version of the software and open the new one. In the
newer version, the user needs to start the command “Migrate prepared projects”. There is an option
to replace the project library with the one from the newer version. A dialogue box appears, and the
users must follow the steps indicated there.

5. If the migrated projects contain links to other models in older versions, all models must be

migrated.

210 Export settings

2101 Exporting to IFC 2X3, IFC 4
IFC (Industry Foundation Classes) is an open, neutral data exchange format. It is optimized for Open BIM
and model-based design among disciplines in the AEC industry. It allows the data to be exchanged between
different tools and even operating systems, throughout the stages of the building design process. As a
neutral file format with an open standard that supports different systems, the IFC schema enables
stakeholders to coordinate building models between the disciplines much easier than in the conventional
approach for design and coordination.
The IFC format can be used for the import and export of 3D elements as well as related non-geometric data,
regardless of the modelling application used, while a preference should be given to certified software tools.
As an ISO-certified schema, it can be integrated into the existing quality assurance policies of a company. It
is developed by buildingSMART and its member organizations.
Even though there are many BIM authoring tools on the market that support IFC export, there are big
differences regarding their approach and scope of the export functionalities which pose a significant
challenge to the user. For additional help, for some of the major tools, some add-ons can be installed to
ease the export as well as additional freeware that imports the 3D geometry that is already

created. One example is the IFC Builder developed by CYPE, which allows the creation of IFC files

Yo
based on 3D or 2D files or to create an IFC model manually. This kind of tool is suitable if there is ﬁ t'.\‘
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aneed for creating an IFC file for energy analysis because it will take only the necessary attributes, allowing

the user to define spaces inside buildings, and eventually exporting an IFC file fulfilling the specific

requirements. For more information visit http://ifc-builder.en.cype.com/.

The process and the information required for an IFC that is used with a certain scope should be detailed in

an Interaction Delivery Manual. This document exemplifies what is the scope of to exchange the models

using IFC format, the roles and their purpose, relevant characteristics of the process that are linked with the
desired BIM Speed use case, and what are the requirements so that the exchange of information is
performed as optimum as possible. The creation of an IDM is standardized, and the guidelines are issued in

ISO 29481-1:2016, ISO 29481-2:2012.

The IDM describes the process and the characteristics but the actual settings of what an authoring tool must

export are done via MVD’s. An MVD, as it is described by BuildingSmart is “is a selection of entities of the

overall IFC schema to describe facilitate a specific use or workflow. MVDs can be as broad as nearly the
entire schema (e.g., for archiving a project) or as specific as a couple of object types and associated data

(e.g., for pricing a curtain wall system)”7. As one will see below, MVD’s are already available in the BIM

modelling tools but further additional settings are still required. These settings are exemplified using the

two software applications chosen for this scope. The export of IFC files from two widely used BIM modelling
software tools will be described in the following subchapter.
2102 ARCHICAD

In ARCHICAD, there are three export functions for IFC files according to the software guide:

o Save as (File menu): exports the entire current ARCHICAD project or just its filtered content to an
entirely new IFC file.

o Merge to IFC Model (File > Interoperability > IFC): merges only certain elements or the entire content
of the current ARCHICAD project into an existing (unopened) IFC file. Users may use this command to
want to add selected content from an ARCHICAD model to an IFC file from another discipline.

o  Publisher (Document menu): publishes views to any of the IFC file formats. For each Publisher item,
you can vary the Translator, so that the view content can be customized to the needs of the recipient,
creating the desired output with a single click.®

No matter the choice, the settings are controlled by an IFC Translator for Export, which defines how

ARCHICAD elements are interpreted and displayed in IFC. When exporting IFC users must choose the

translator.

The main steps that a BIM designer needs to follow to export a model to IFC are:

o Choose the IFC export command desired (Figure 12): File > Save as... or File > Interoperability > IFC >
Merge to IFC Model

7 https://technical.buildingsmart.org/standards/ifc/mvd/

-
8 https://helpcenter.graphisoft.com/user-guide/128889 "
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Figure 12 ArchiCAD - Step 1 in saving IFC®

Cancel

1. Select the type the intended file type. When using the “Save as” command multiple types of files
may appear but when the command “Merge to IFC Model” is used, only the available IFC file types
are displayed. (Figure 13)

2. Define the name of the file. One should use the “Filename” field to define a file name (Save as) or
browse for an existing IFC model (Merge to IFC Model).
Choose a Translator for Export (Figure 14)

4. Filter Model at Export. As needed, users can further filter the set of elements to be exported, using
the Elements to Export dropdown and/or the Model Filter dialogue box; both available from IFC
Save Options.

5. Export - Click “Save” (Save as) or “Open” (Merge to IFC Model) so that the export process will start.
W Open X
v @2 e @

Date modified

Look in: ‘

*

IFC Models

Name Type =

_ ® Design Studio 4/22/2016 218 PM IFC Files
Quick access #| Design Studio_backup_2016422111252 /22/2016 11:07 AM IFC Files
® Design Studio_backup 2018422141841 2272016 11:12 AM IFC Files
- ) Design Studio2 /372017 3:55 PM IFC Files
Desktop | Design Studio2_backup_201723153511 4/22/201611:13 AM IFC Files
- ®| Hotel /26/2016 2:07 PM IFC Files
™M ®| Hotel_backup_201642614713 /22/2016 1:32 PM IFC Files
Libraries @) IFC Analysis Madel /82012 355 PM IFC Files
@ IFC Architectural 3/8/2012 3:35 PM IFC Files
! ®| IFC Columns as Stair Flights 1/25/2017 3:39 PM IFC Files
Thi;-PC &) IFC MEP Madel 3/8/2012 3:34 PM IFC Files
_ ) IFC Structural Model 10/10/2014 2:00PM IFC Files ¥
@ £ >
Network Translator: | General Export V| Settings...
File name: | - | Open
I Files of type: IFC Files ("ifc: * ffcxml; " ffczip w I Cancel

Figure 13. ArchiCAD — Step 2 in saving IFC1©

° https://helpcenter.graphisoft.com/user-guide/65781

10 https://helpcenter.graphisoft.com/user-guide/65781/
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X Export: Visible elements (on all staries) v Filter..
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AECOsim Building Designer Export
File name: &liplan Engineering Expart
Save astyps BIM4¥ou (4D/5D] Export Cancel
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DDS-CAD MEP Export
Exact Geometry Export
IFC2 Design Transfer View-based Export
IFC4 Reference View-based Expart
iTWO (5D] Export

Plancal nova Export

Revit Export far Reference Model

Revit MEP Export

Revit Structure Export

Scia Engineer Export

Structural Analysis Expart

Tekla Structures Export

Figure 14. ArchiCAD - Selecting IFC translator®

The “Merge to IFC Model” command is not suitable if the goal is to merge changes from one version of a file
to another because this command only adds new elements but does not override the existing ones.

An IFC Translator (Figure 15), defines the rules for how the elements should be converted and how they
should be interpreted by any software - whether in ARCHICAD or another application reading the IFC file.
Translators are listed by name on the left side. The Translator name exemplifies its use, e.g., “Import from
Modelling Applications” or “Export to Tekla Structures”. They are divided into Translators for Import and

Translators for Export.

B IFC Translators ? >
4
7 la | | Name of Translator for Export:
Mame |GEnEraI Expart
~ Translators for Import + Description:
Exact Geametry Impart Export for general purposes. It tries to export as more parametric elements as

General Import possible with a defined set of properties.

Import fram Madeling Applications

Import from Tekla Structures

~ Translators for Export + T SETTINGS
COBie 2 Bxpart (UK} IFC Schema: = Bic)
COBie 2 Expart (U5}
Model View Defintion: [ coordination view version20  v|[@

Concept Design BINM 2010 Expart
Export to AECOsim Building Designer Name of Custom MVD:
Export to BIM4You

Export to Tekla Structures [Comeso e

I [V General Export Madel Filter:

‘ All 3D elements v‘

Type Mapping:
‘ Standard IFC Type Mapping \,‘

Geometry Conversion:

‘ Extruded geometry - only if participates in collision detection v‘

Property Mapping:
‘ Standard IFC2x3 Scheme v‘

Data Conversion:
‘ AllIFC data v‘

Unit Conversion:
‘ Wetric (EUR) v‘

Hew.. Delete Set Preview 5 |- Cancel

Figure 15. ARCHICAD - types of IFC exports*?

>
1 https://helpcenter.graphisoft.com/user-guide/65781/ ‘;"‘
12 https://helpcenter.graphisoft.com/user-guide/65791 . -
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Users can create new translators for exporting. The different settings that can be chosen are in the right

part of the dialogue box. Detailing the settings includes:

o Name - users set the name of their translator

o Description —short description is necessary to be included so that other users will know the scope of
the export settings.

e IFCschema - allows the selection between exporting to IFC 2x3 or IFC 4.

e Model View Definition — the proposed MVD that can be selected are according to buildingSMART
Internationall3 or other organizations. They are predefined by the software according to the
regulations, making sure that the IFC is compliant with them. Depending on the IFC schema selected,
MVDs are available. As an example, for IFC 2x3 there is a Coordination View. If IFC 4 is selected, the
Coordination View is divided into two and the user will have to choose between IFC4 Reference view
and IFC 4 Design Transfer view depending on the intended use of the IFC file

o Model filters — allow the user to select which elements should be exported.

e Type mapping —is detailed below.

o Geometry conversion lets the user select how the geometry of the elements is exported. To mention
only a few: Extruded geometry — elements that are relevant for collision detection, export geometry of
IFC Types, Use BREP geometry in current colour for all elements.

e Property mapping — shows the IFC properties assigned to elements when exported. The user can also

create and assign custom IFC properties (Figure 16).

B Map IFC Properties for Export 7 *
IFC Entities: | I IFC Properties: I 4 Mapping Rules im Order of Priority.
Ti | Stiuetural ~ Mame Tpe
~ $ I cBuildingElement Component] i - (il -
& IcBuildingElementPart Giobaik MfcRoot R GloboijUni.
v @8 (FReinforcingElement) FE (L) esbe
@ WReReinforeingBar Description (fcRoot) fTet
@B ifcReinforcngMesh ObjectType McObject) Helabel Mew Rule Delete
Qv WeTendon Tag (ifcElement) Hcldentifier
$ ifeTendonanchor CREIE L —— i) Fute content
(13 WcBuilding ElementProxy v X Pset ConcreteElementGeneral =
{| Heconmn v Pset_ConcreteElementQuanti..
B IcCovering 3 Pset_Draughting
Bt mecurtainwan b P RameniShating
A tedoor b Pset_FireRatingProperties &
@ McFooting 3 Pset_ManufacturerOcourrence L]
1} ticMember » Pset_ManufacturerTypelnfor., &
U WePile 3 Pset_Packinginstructions
M ticPiate b ¥ Pset_PrecastConcreteflement... =
T HeRailing 3 Pset_Productflequirements
<= HeRamp L Pset_QuantityTakeOff
< HcRampFlight b 3 Pset ReinforcementBarPitch...
P HeRoot b Pset_Reliability
= HeSlab b Pset_Risk .
W MeStain w
Clear All Settings Hew... Import from current Project Add Caontent... - Remove
T, Warnings.. Candel
Figure 16. MAP IFC properties for exporting elements in ARCHICAD.
Yo
-
13 https://technical.buildingsmart.org/standards/ifc/mvd/mvd-database/ f -
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o Data conversion allows the user to choose, which data, besides the geometry, should be exported.

There are a few pre-sets like “all BIM data”, “all IFC properties”, etc. From here, one can also select if

data for quantification or space boundaries are required (Figure 17).

e Unit conversion allows the user to select the units for the conversion.

E Data Conversion for IFC Export

Available Presets

Al BIM data

LINIFC properties

Mapped properties and derived data

Mapped properties only

New... Rename...

Select ARCHICAD Data to Export:

O Classifications

[ Element Properties

[ Building Material Properties
[ Element parameters

O component parameters
Dioar-Window parameters
[ Zone Categories

Expaort IFC Properties:

(®) Al IFC Froperties

Select Derived Data to Export:
[IiFC Base Quantities
[IFC Space Containment

[JFC Space Boundaries

(®) Keep ARCHICAD IFC IDs [recommended)

() Generate new values

() Only Praperties set in Property Mapping for the selected Translator

IFC Global Unique Identifier (Globalld) Attribute:

Delete B

Filter Containment..,

Figure 17. Data conversion for IFC Export in ArchiCAD.

An important step before exporting is to Type Map. This refers to what IFC proprieties users want to be

displayed after export. Therefore, one needs to assign, for every element, an IFC Type, which can be done

either by element or by classification (Figure 18).

Reset Mapping |

& Map IFC Types for Export ? X
Mapping by OEIementType Source Classification System:
(®) Classification | ARCHICAD Classification - 21 ~
Classification IFC Type
= Q | | Mapping Status: by Parent
~ & ARCHICAD Classification - 21 " HELT
> ) Construction Element IFC Type
> Cpenin
’® P g IfcBuildingElementProsxy 13
> ) Massing
» ,@ Element Assembly Predefined Type:
> Element Component
@ P IFC Type Product
> ,@ Reinforcement
IfeBuildingElementProxyType L3
5 B Furnishing | g My Typ |
> ) MEP Element v Predefined Type: NOTDEFINED v

| Cancel | I oK I

Figure 18. ARCHICAD - IFC Type Mapping®*

4 https://helpcenter.graphisoft.com/user-guide/89323/
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Mapping “by Element” type assigns each 3D object type automatically to a default, basic IFC Type,

corresponding to its ARCHICAD tool or (for GDL objects) to its Object Subtype. If this method is chosen, no

further manual mapping is needed.

If one decides to map the objects “by classification” to an IFC Type, Type Product, and/or Predefined Type,

the method allows for flexible and detailed IFC Type classification, according to specific IFC standards.

Users must choose a Classification System to display its classification structure in the tree and then map IFC

types to the classified 3D objects when exporting.

Depending on the BIM Use case that IFC file is supposed to support, a few settings can be made in terms of

how the data is exported:

o Property-type element parameters as IFC Properties: Export the parameters only if the Use Case
requires this since it will significantly increase IFC file size

o Property-type element parameters as IFC Quantities: If the BIM Use cases require quantity take-off
this box should be ticked to export parameters that convert to IFC Quantities (e.g., Weight, Length,
Area, Volume, Time).

o Zone Categories as IFC Space Classification Reference: export the Zone Categories data (Code and
Name) of ARCHICAD Zones as IFC Classification Reference data.

o IFC Base Quantities: check this to export Quantity Take-off parameters (size, area, and volume) to IFC.
Useful in cost estimation applications.

e IFC Space Containment: export data defining the relationship between ARCHICAD Zones and objects
they contain. This feature is useful in facility management applications.

o IFC Space Boundaries: Export geometry data of ARCHICAD Zones. (Useful in thermal calculation
applications.)

2103 REVIT
Exporting IFC from REVIT can be performed from File -> Export -> . IFC (Figure 19). A new window will
appear on the screen where various actions can be performed, namely choosing the location of the IFC file,

naming the IFC file, and set up the export.
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DWF/DWFx
Creates DWF or DWFx files.
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Figure 19. REVIT — Export IFC.

There are 3 different versions for the IFC file that REVIT can export to IFC 2x3, IFC 2x2, IFC 4 (Figure 20). The
main ones are IFC 2x3 and IFC 4. Although IFC 4 is the newer version, IFC 2x3 is still the most used version

on the market and a large variety of software use this version.

Modify Setup x

<In-Session Setup> General | Additional Content | Property Sets | Level of Detail | Advanced
<IFC2x3 Coordination View 2.0 Setup>

«|FC2x3 Coordination View Setup> IFC version (G2 \CooniinationiMichie ) ’
IFC2x3 GSA C t Design BIM 2010 Set
<IFC2x; ) oncept Design etup>) type IFC .
<IFC2x3 Basic FM Handover View Setup>
<IFC2x2 Coordination View Setup> Phase to export New
<|FC2x2 Singapore BCA e-Plan Check Setup>
<IFC2x3 COBie 2.4 Design Deliverable Setup> Space boundaries 2nd Level v
<IFC4 Reference View Setup>
Coordinate Base Shared Coordinates £2

<IFC4 Design Transfer View Setup>

3M
Split Walls, Columns, Ducts by Level

Include Steel Elements ‘

File Header Information... |

‘ Project Address... |

E’ED@’\‘_L]EB Cancel

Figure 20. REVIT — Setup when exporting IFC.

Set up categories to consider based on types of settings (note that the number of options can be different
from REVIT 2016 to REVIT 2020):
e General tab

— IFC Version: IFC 2x3

—  File Type: IFC

»>
be:‘
N
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— Phase to export: If the option "Export only elements visible in view" is selected and no
modelling phase setup is needed. If not, a modelling phase must be set up. REVIT only can
export one modelling phase at a time and not all the phases in the model.

—  Space boundaries: users can choose from “None” (room/spaces not exported), “1% level” (the
room/space boundaries are included but are not optimized to split elements concerning
spaces on the opposite side of the boundary) or “2"¢ level” (the room/space boundaries are
included and are split concerning spaces on the opposite side of the boundary. A second level
space boundary considers the material of the building element and the adjacent spaces behind
it, providing thermal properties, for example).

—  Split Walls, Columns, Ducts by Level: This allows the model to be divided into multi-level walls,
columns, and ducts by level. When this option is set, REVIT cuts the walls, columns, and ducts
by each level that is defined as a building level.

— Coordinate Base: options are “share coordinates”, “survey point”, “project base point”, “internal
origin”. It is recommended to use “share coordinates” since most models are set on coordinates.

o Additional content

—  Export 2D plan view elements: One must select this option to include 2D elements supported
by IFC export.

— Export linked files as separate IFCs: The user will select this option to export REVIT links in the
model as separate IFCs. It is strongly recommended to export each model to IFC from its
original Reuvit file.

— Export only elements visible in view: One will select this option to export only the visible
elements of the current view. This is highly recommended since the BIM model contains MVD
specific to each BIM Use Case.

— Export rooms in 3D views: If the "Export only elements visible in view" option is selected,
selecting this option exports all rooms contained inside the section box of the selected 3D
view. Usually left unticked.

e Property sets:

— Export REVIT property sets: This option allows users to include the REVIT-specific property sets
based on parameter groups. If selected, then the export will contain all the parameters of the
REVIT family, filling the IFC files with unneeded information. There is the option to only export
data defined by property sets, which enables a user to define based on a .txt file. (Figure 21).

— Inthe file, parameters can be grouped in certain sets, according to companies' shared
parameters files or BIM Use Cases for a clearer view. For example, one might create a
parameter called LOD to specify the LOD of each element in case there is a need to work with
different LOD on a project (depending on the BIM Use Case). This LOD parameter will be

included as a BIM parameter. For this, a new propriety set will be created in the .txt
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file and when the export is done this LOD parameter will be grouped under BIM parameter set.

Modify Setup X

<In-Session Setup> General | Additional Content | Property Sets | Level of Detail | Advanced
<|FC2x3 Coordination View 2.0 Setup> .
o [] Export Revit property sets
<IFC2x3 Coordination View Setup> c c
xport IFC common property sets
<IFC2x3 GSA Concept Design BIM 2010 Setup> P n property
<IFC2x3 Basic FM Handover View Setup> L Export base quantities

<IFC2x2 Coordination View Setup> [ Export schedules as property sets

<IFC2x2 Singapore BCA e-Plan Check Setup> [ Export only schedules containing IFC, Pset, or Cammon in the fitle

<IFC2x3 COBie 2.4 Design Deliverable Setup> Export user defined property sets

<IFC4 Reference View Setup> C:\Program Files (x86)\Revit IFC 2019\DefaultUserDefinedParameterSets.txt

<IFC4 Design Transfer View Setup>
[] Export parameter mapping table

Browse ...

| Classification Settings...

ED’&EB | 0K | ‘ Cancel

Figure 21 Exporting property sets from REVIT

—  Export IFC common property sets: One must select this option to include the IFC common
property sets.
— Export base quantities: If the exported IFC is to be used for Quantity take-off BIM Use case, this
option should be checked.
— The rest of the properties in this tab should be unticked. If you own a parameter mapping table
or special property sets then tick the appropriate boxes.
o Level of detail — set to extra low. This will decrease the file size and will not affect the parameters
exported.
e Advanced:
—  Export parts as building elements: Users can select this option to export parts as standard IFC
elements. Clear the option to export them as IfcBuildingElementPart.
— Allow the use of mixed "Solid Model" representation: Select this option to allow for mixing
BRep and extrusion geometries for an entity. This can result in smaller IFC files, but the files are
not strictly within the standard IFC MVDs.
— Use an active view when creating geometry: one must select this option to use the active view
to generate the exported geometry.
— Use family and type name for reference.
— Use 2D room boundaries for room volume: For IFC 2x3 this option should be unchecked.
— The rest of the choices should be unticked.
Recommendations:
o For Phase export: it is advisable to create a 3D view specially made for IFC export. This view should be
without any view templates, or any graphics overrides made and should only be with the elements
from that model (e.g., if an MEP model needs to be exported to IFC, the 3D view will contain only MEP

B

families).
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e Space boundaries depend on which BIM Use case you use the IFC file. For example, for energy
analysis, it is best to choose “2™ level”.

o If "Export only elements visible in view” is selected, one must consider that elements that are
temporarily hidden are not exported. Categories marked as “Not Exported” in the IFC Export Classes
dialogue are also not exported.

Before exporting an IFC from REVIT, one should check the IFC Mapping (Figure 22). The option can be found

in the “File” tab -> Export Options ® (IFC Options). BIM designers have two possibilities: either load the

mapping from an external file or change the very setting manually (and save them). If the “Standard” option
is selected, one will be able to create a new mapping, having the default mapping as a base. It is
recommended that a first setup is done manually to ensure that every item is mapped according to its
category. Certain software, when using the IFC file, requires specific settings to be made. CYPETHERM, for
example, requires that curtain walls be defined as IfcWindow and not as IfcCurtainWall. Because of these

particularities best is to have multiple IFC mapping file.

IFC Export Classes: C:\ProgramData\Autodesk\RVT 2020\exportlayers-ifc-1AlLtxt X
3 = Load...
Revit Category IFC Class Name IFC Type
Standard
3D DWG_MakerG9_26.09.20/Not Exported
0 Not Exported Save As...
Air Terminals IfcAirTerminal
Hidden Lines IfcAirTerminal
Medium detail IfcAirTerminal
Plate IfcAirTerminal
Terminals IfcAirTerminal
Analytical Beam Tags Not Exported
Analytical Beams Not Exported
Analytical Brace Tags Not Exported
Analytical Braces Not Exported
Analytical Column Tags Not Exported
Analytical Columns Not Exported
Analytical Floor Tags Not Exported
Analytical Floors Not Exported
Analytical Foundation Slabs |Not Exported
Analytical Isolated Foundati|Not Exported
Analytical Isolated Foundati|Not Exported
Analytical Slab Foundation T|Not Exported
Analytical Wall Foundation |Not Exported v

Figure 22. REVIT — IFC Mapping

REVIT allows users to create generic 3D objects that can be used for multiple categories. This is not a
recommended way of working but a situation like this occurs. For these objects, an IFC class still needs to
be chosen. Because of this, two shared parameters should be created and named “IFCExportAs” and
“IFCExportType”. Every generic family should have these two parameters included, grouped under the “IFC
Parameter” category, and filled in.

2104 Export to other formats

A list of different file formats which some software applications can export is listed in APPENDIX 1 - BIM

SPEED METHODOLOGY TOOLKIT.
»
£
)\‘
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2D CAD drawings may be still required to be exported. REVIT and ArchiCAD have different approaches to
this. REVIT can export dwg, dwf, dxf, dgn. If the requirements are to have elements on specific layers (with
defined colors and names), a layer mapping will be needed, since Revit assigns each element from the
model (either 2D or 3D) to a predefined layer. These settings must be part of the template.
ArchiCAD needs a translator (similar to exporting to IFC) to be able to export to dwg, which is embedded in
the software. In the translator, one must define layer mapping (layers in ArchiCAD do not have a color or a
line type), file format, model space, attributes, hatches, etc.
Another file format allowed by both software that is largely used is .nwc. From REVIT, this is done while
exporting any other files, but for ArchiCAD, an add-on called “Navisworks Connection” is needed.
To perform energy analysis other types of files can be used besides IFC. A file that can be exported directly
is a .gbXML file. It can be used directly or to create a .idf file (a type of file used by EnergyPlus to perform
energy simulation). Before exporting to a gbXML file, all the settings regarding location, weather, and space
specification must be made. The file should be checked since there can be geometrical errors as in the way
the file understands some connections between elements.
With REVIT 2020 energy analysis can be formed directly using the 3D model. The engine behind the
simulations is from EnergyPlus and DOE2. After the analysis is done, from Autodesk INSIGHT it is possible

to export a .idf file. Other formats that require special attention are .dwg.
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AS-BUILT Model creation

Creating an as-built model compared to making a new building model may seem a lot easier since the first
assumption is that the building is already constructed, and all the data is there and thus no need for
iteration, as it often is the case when designing new buildings. However, in reality, data is not always
available and has to be gathered ( See Deliverable 1.1 and 1.2. for the proposed data collection methods).
But even if the data is available, there are occasions where the data is incomplete (e.g., not all floor plans
are available, schematics can be missing).

In the following subchapters, we describe the steps needed to work with various types of files to create as-
built BIM models. To achieve an accurate model representing the reality of the existing building, Different

workflows for different data types are proposed.

31 Model creation

Based on point clouds

Scan to BIM or the process of creating a 3D model of a building using 3D scans is used more and more in
the last years. Point cloud data set can be generated in different formats, such as .xyz, .pls, .fls, however,
most 3D modelling software applications allow to import of only a few of them. For example, ArchiCAD
allows the import of point cloud data sets as .e57 and .xyz while REVIT does not allow a direct import of
points cloud. REVIT allows only .rcp or .rcs files to be imported, types that are created using Autodesk RECAP.
RECAP allows a great number of formats of point clouds (Figure 23) to be imported. After they are processed,
the point cloud datasets can be exported in one of the two formats supported. Similar to RECAP, there are
Bentley Pointools and other software applications provided by manufacturers of 3D-Laser scanners (for
example Riegl RiSCAN Pro, Trimble RealWorks, FARO Scene, and Leica Cyclone.)

All Supported Files (*.rcs;* fls;*.fws;* Isproj;*.pts;*.ptg
Autodesk ReCap Scans (*.rcs)
Faro FLS Files (*.fls)

Faro FWS Files (*.fws)

Faro Project Files (*.Isproj)
Leica PTG Files (*.ptg)

Leica PTS Files (*.pts)

Leica PTX Files (*.pt)

Lidar LAS Files (*.1as)

Lidar LASZip Files (*.laz)
Zoller&Frohlich ZFS Files (*.zfs)
Zoller&Frohlich ZFPRJ Files (*.zfprj)
Topcon CL3 Files (*.cI3)

Topcon CLR Files (*.clr)

E57 Files (*.e57)

Riegl Files (*.rdbx)

Riegl Project Files (*.rsp)

Text Files (*.txt)

XYZ Files (*xyz)

Autodesk ReCap Projects (*.rcp)
DotProduct Scan File (*.dp)
Leica Raw Project File (*.prj)

Faro XYB Files (*xyb)
zl |AII Supported Files (*.rcs;* fls;* fws;* Isproj;*.pts;* ptg

Figure 23. Point Cloud formats supported by Autodesk Recap

s
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Point clouds can only contain information regarding the position of elements, the signal intensity of the

surface reflection, and its color depending on the system used. Every point has a x, y, z coordinate, and a

multitude of points represent the captured elements. Information regarding the material and other physical

characteristics describing the condition of the captured building elements are not covered by the point
cloud and need to be included during the modelling process.

Creating a 3D model based on a point cloud can be done using two procedures:

e Manual modelling

e Automated modelling

Manual modelling refers to importing the point cloud and modelling using the file as a reference. Before

starting the activity, a few steps must be considered:

- Point cloud datasets should have enough point density to be able to make the elements
visible and distinguishable

- Before inserting them into the model, the point cloud must be cleared of any unnecessary
elements. For example, if the surrounding environment is not relevant for the activity, the
points representing the surrounding environment can be deleted. This will reduce the file size
of the point cloud and thus making it easier to use.

- Another method to improve the handling of the point cloud inside the model is to split the
point cloud into floors and insert and model floor by floor. This way it is ensured that the
model is not lagging.

Below we propose a number of recommended actions that one must take when a point cloud dataset is

linked or imported:

e Inthe case of REVIT, the point cloud dataset should be placed on its work-set. If the point cloud has
been split, for every part a work-set should be created. When opening the model, those work-sets can
be closed, thus the model will open faster.

o For REVIT, create specific view templates to display point clouds in view. In the rest of the view
templates, point clouds should be disabled. In this way, when a user wants to display a point cloud on
a view, the view template can be used and the work-set will be activated.

o Link the point cloud from the local drive. Although all the files are on cloud platforms, it is best to
download and use the dataset from the local drive. When the work is finished it can be relinked from
the platform. This has shown an improvement in the performance of the BIM model.

o For ArchiCAD, do not import files that are bigger than 4 Gb. If the file is bigger, it should be split.

Automated modelling requires the use of specific techniques such as object detection, semantic

classification, or model fragmentation. These techniques are described in D1.2 Methods for surveying and

diagnostics of HVAC systems in the existing buildings.

There are already a few software applications available in the market that have implemented these

techniques and can be used within a certain degree of performance (EdgeWise and FARO As-built

are two examples). These two software applications allow the identification of walls, floors,
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piping, ducts, cable trays. During an internal test with EdgeWise on a point cloud dataset for different types
of buildings, the software showed reasonable results but also some mismatches (mainly rectangular ducts
and complex architectural fixtures were not recognized). In deliverable 1.1, Methods for Data Acquisition,
an add-in for Revit has been developed. The plugin is called 3D Dash Tool and its aim is to automatically
detect architectonic features from a point cloud.
In the case of renovation projects, depending on the type of renovation, only some parts might be needed
to model. In this situation, BIM modellers will focus more on the important parts of the renovation while
detailing less the other parts of the building. As an example, in terms of facade renovation work, the
elements of the facade will be modelled with a higher LOD than the rest of the building, which is needed
just to highlight the volumetry of the building. In this case, a parameter/property should be created to
differentiate between different types of elements.
Another situation can be that from a point cloud dataset, some elements are clearly visible and there is
enough information to identify the elements properly while other parts are not easily distinguishable. In
this case, a new set of parameters/properties should be defined that indicates the status of the element:
o defined — where the dimension and location of the element are verified on-site.
o undefined geometry - if there is not enough information regarded to geometry
« undefined position - if the position is not checked on-site, for example, a pipe placed inside a wall or
in a shaft that is not accessible.

e Undefined - both position and location are not known.
These are only a couple of proprieties/parameters that can be considered when modelling existing
buildings but not this list should not be considered restrictive. Depending on the number of
parameters/proprieties inserted in a model, as mentioned in chapter 2.10, one must consider how these
parameters to IFC and how it wants them to be visualized.

312 Based on CAD drawings
CAD drawings along with PDF files represent the most common information sources to create as-built BIM
models. Most of the 3D modelling software tools allow the import of CAD files, under different formats. The
most common format used is the .dwg but also .dxf, .dwf or.dgn can be used.
REVIT works with CAD files in two ways (Figure 24): either creating a link to that specific file or to import

directly into the model.

Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site Collaborate  View Manage  Add-Ins

P BRC U Y@ F fprio) 3 Gl MO

Modify| Link Link Link DWF Decal Point Coordination Manage Import Import Insert Manage Load Load as
Revit IFC CAD Markup v Cloud Maodel Links CAD gbXmL from File Images ~ Family Group
Select « Link Import ¥ |oad from Library

Figure 24. REVIT — Insert tab for linking or importing
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The two methods have some particularities that differentiate their use that is highlighted in Table 3.

Table 3. Importing CAD files versus Linking CAD files in REVIT

Importing CAD files Linking CAD files
Connection to the Loses all connections. Keeps connection
source file
Updating file The files must be imported again | Files will be updated automatically
when opening REVIT
Editing elements Elements can be edited, Elements cannot be edited
inside CAD files exploded

Recommendations before using any of the techniques:

e Unwanted data from the CAD file should be deleted. This will reduce the file that will be imported
into the BIM modelling tool.

e Either using a link or import functionality, every CAD file should be audited and purged for unused
elements.

o Freeze or close the unnecessary layers.

o Make sure that all elements are assigned to the correct layer. This will result in better manoeuvring of
the CAD file inside the BIM tool.

When using REVIT, one must also consider the following:

o Never explode the CAD file inside the REVIT model. If data is needed from the CAD file into REVIT, use
a sandbox file where the CAD file is exploded and only the desired elements are copied.

o Linked CAD files should be placed on a work-set designated for this operation.

e Linked CAD files should be placed only on the required views.

For ArchiCAD, the recommended solution is to use the DWG as an external reference. To do this, one must

go to “File-> External Content -> Attached XREF” (this option is similar to Linking a CAD file in REVIT as well

as attaching an XREF in AutoCAD). In this way, the linkage can be deactivated after the modelling is done.

The CAD file will be imported as a non-editable block. Another option offered by ArchiCAD is to place it as

an “external drawing”. This allows the user to pick the parameters from the drawings without importing all

the attributes from the file. The last option offered by ArchiCAD is to merge the DWG file into a project, but

this means that all items in the drawings will be part of the project, which is not recommended because one

may end up with a lot of attributes that are not useful, making the handling of the model harder.

A technology developed rather recently that helps speed up automating modelling using CAD

Yo
drawing is Flexijet 3D (www.flexijet.info). With this technology, measuring points are directly ﬁ] "“
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linked with CAD drawing commands to produce finished 3D CAD drawings that can be inserted afterward
in a BIM Model. It reduces time because the measurements of the elements are accurate (to the millimeter).
It is already a 3D representation of elements and there is no more need for point cloud or CAD post-

processing.*®

Based on pictures

Most software allows the insertion of pictures in a BIM project, but the files will act as underlays, such as a
.dwg or a PDF. However, photogrammetry can be used to create a 3D object based on pictures, more
automatically. This technology offers a few types of outputs that can be used in BIM projects as starting
points in preliminary design. They can also be combined with lasers or LIDAR scans to receive an accurate
representation of existing objects or sites, close as possible to real objects.

The use of photogrammetry in the AEC industry has a lot of potentials and can be implemented when
gathering on-site data and generating the surrounding environment, complex facades, recreating 3D
positioning of MEP components, alignment of MEP components with proper proportions, material
representation, detailed fixtures in a 3D format. Photogrammetry software can offer the following useful
outputs: point clouds and 3D Meshes.

Previously, it was presented how point clouds, from laser scans, are used in a BIM model. Point clouds
generated with photogrammetry are not that different but have two characteristics that one should be
taken into account:

e Thedimensions are less accurate.

o Have more details, colours, and faster data collection.

The point clouds are inserted in the same manner as the ones coming from laser scans, so all
recommendations, from 3.1.1, should be followed.

Photogrammetry allows the creation of 3D Meshes based on a series of photographs of existing buildings
or other objects with a high level of detail and textures. They can be incorporated in a BIM project as a
reference. The advantages of a 3D Mesh in contrast to point clouds are that it is very easy to identify and
interpret the captured elements. Depending on the resolution they can be used in technical designs with a
high degree of reliability. 3D Meshes can be imported in most 3D software. Generating good results depend
on the photogrammetry software used and the outcome desired. An example of open-source software
worth mentioning is MeshLab), but also commercial products such as Agisoft, Bentley ContextCapture, and
Autodesk Recap.

In Deliverable 1.2 there are recommendations on how to collect proper images to use in photogrammetry.
Based on PDF files

PDFs are one of the most common sources of design drawings. As-built BIM models can be developed
starting from PDF files. As is the case with CAD drawings mostly all BIM modelling tools allow the import of
PDF files (with REVIT it is possible only from 2020 version). Also, like in CAD drawings, information
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needs to be placed manually inside the 3D elements, because there is no way to extract and insert the
information automatically.

Before inserting PDF and starting the modelling, one needs to be aware that the file is at the correct scale
and size. Depending on the software used scaling a pdf might be possible with similar methods used to

scale a PDF in a 2D drawing.

3.2 Working with phases

BIM modelling for renovation projects, as mentioned in subchapter 2.6, can include a minimum of 3
modelling phases: existing phase, demolition phase, and new phase. Depending on the software used the
phases can have different names but the main idea is the same: when creating elements in an as-built BIM
model attention should be given to phases.

There is no limit to the number of modelling phases that can be created but the recommendation will be to
not create too many since it will burden the modelling tasks. When creating a new modelling phase, the
name assigned should be clear and concise and should also include a timestamp (year, quarter, month). In
the following subchapters, a few recommendations on how to work with phases for the 2 different software
applications are presented.

REVIT Phases

In REVIT there are two default modelling phases; “existing” and “new”. When the Master Model is set up, all
the modelling phases should be created there. Each model should have the same phases defined as in the
to the master model. To perform “phase map” command, one must select a link, and in the properties should

go to “Phase Mapping”. To create phases in REVIT, go to Manage-> Phases (Figure 25).

Architecture  Structure  Steel  Systems Insert Annotate Analyze Massing & Site  Collaborate  View Manage Add-Ins  T4R:Network License  T4R: Create/Modify  Quantification  Site Designer
% @ @ Object Styles EE Project Parameters ‘E Transfer Project Standards Ea 2 % @ & l% @] ,,%
&
P - ’ P J
Modify| Materials n Snaps .g Shared Parameters [@ urge Unused EE Additional L Design Manage Eﬁ Phxes W ('\17
roject Information obal Parameters roject Units ~  Settings - ptions Main Model - inks 6@ %3 :
0% Project Inf Global P: B Project U E3 Sett [ Main M Links 7
Select v Settings Project Location Design Options Manage Project | Phasing | Selection Inquiry Macros

Figure 25. Phase tab in REVIT.

After clicking on “Phases”, a dialogue box will appear (Figure 26) where they can be defined or filtered.
Graphical overrides can also be defined, but one must consider how the project template is setup as well
as the hierarchy for graphic overrides. Modelling phases should define the most important milestones inside

the project. Activities may be combined and placed in a single-phase if possible.
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Project Phases Phase Filters Graphic Overrides

PAST

Name

2 |Demolished

Description

3 |New

FUTURE

OK

Cancel

Apply

Insert

After

Combine with:

Previous

Next

Help

Figure 26. Defining project phases in REVIT
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The phase filter (Figure 27) works similarly to the view filter. The difference is that they relate to the

modelling phases. Users can choose a display mode using these filters. Phase filters can be controlled either

by view or from a view template and the recommendation is to control it from the view. The reason behind

this is because a view template contains a lot of settings and most probably it is applied to a great number

of views that may not display the same phase, thus requiring to place different phase filters.

Figure 27. Phase filters in REVIT

Phasing X
Project Phases Phase Filters Graphic Overrides
Filter Name New Existing Demolished Temporary

1 Show All By Category Overridden Overridden Overridden

2 Show Complete By Category By Category Not Displayed Not Displayed
3 Show Demo + New By Category Not Displayed Overridden Overridden

4 Show New By Category Not Displayed Not Displayed Not Displayed
) Show Previous + Dem Not Displayed Overridden Overridden Not Displayed
6 Show Previous + New:By Category Overridden Not Displayed Not Displayed
T Show Previous Phase :Not Displayed Overridden Not Displayed Not Displayed

OK Cancel Apply Help

The Graphic overrides (Figure 28) allow modelers to control how elements are viewed based on phases.

These settings will affect every element in that modelling phase status. Unfortunately, the modelling phase

is not a parameter based on which a user can create a filter.
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Phasing X

Project Phases Phase Filters Graphic Overrides

Projection/Surface Cut .
Phase Status = = Halftone Material
Lines | Patterns Lines | Patterns
[Existing | _ ——ffidden O |S4R-Existing
Demolished — % % I — : O | 54R - Demolish
New — — O S4R - New |
Temporary i — — O S4R - Temporary |

| el || sy [ help
Figure 28. Graphic Overrides for phases in REVIT
322 ARCHICAD phases
In ArchiCAD, modeling phases are easier to work it. The software has embedded a Renovation Palette,
where three modeling phases are already defined: “Existing”, “New” and “To be demolished”. One may also
select the relevant phase when creating elements. By default, all elements will have the status “Existing”

(Figure 29 a and b).

Renovation n Renovation n

Default Elements: Default Elements:

[gla = s 2 alE S

Renowvation Filter: Renowvation Filter:

|u1 Existing Plan v|| 04 New Construction v|
a) b)

Figure 29. Phases in ArchiCAD1¢

Renovation Filters can be used to display the project to reflect different stages of renovation (such as
“Demolition Plan” or “New Construction”). ARCHICAD comes with several predefined Renovation Filters, but
users can change the options at Document > Renovation > Renovation Filter Options.

ARCHICAD, like REVIT, has its predefined Override Styles for each of the three Renovation Statuses. To
change these default styles, the Graphic Override Rules dialogue box should be used (Document > Graphic
Overrides > Graphic Override Rules).

ARCHICAD’s Renovation feature depends on assigning the proper Renovation Style to individual elements
and then displaying them in the different filters corresponding to the different stages of the renovation

process. In most cases, once modelers have assigned element styles and defined filter options,
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graphical feedback can be viewed just by clicking from view to view - from Existing Plan to New

Construction to Planned Status. The display of elements changes automatically.
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4. Conclusions

The scope of Deliverable 2.4 was to establish a set of practical steps to be taken by any company to perform
renovation projects in a BIM environment. The document has highlighted and identified the differences that
one may encounter in modelling new buildings and renovation projects. All the proposed steps were
contextualized for two BIM tools available in the market: REVIT and ArchiCAD. Specific examples were
given to better demonstrate the proposed steps. Moreover, the document has illustrated the need and the
required parameters for a “BIM Model project template” for renovation projects as well as specific items to
be taken into consideration when creating an MEP template for this kind of projects. 3D objects for
residential projects were a topic tackled in this document highlighting the differences between new and
renovation projects, as well as guidelines for including MEP 3D elements in a BIM model for renovation
projects.

It was highlighted that part of the modelling process is about exporting to other file formats. Exporting the
information from the BIM model in other file formats is of great importance with special consideration to
ifc format for OPEN BIM workflows. Exporting from .ifc from REVIT and ArchiCAD was detailed and
explained illustrating the importance and the use of .ifc files.

Building a BIM 3D model of an existing residential building relies on the information given by the building
owner (e.g, existing 2D plans) and collected from the site (e.g, point clouds, pictures). Methods to collect
data are shown in Deliverable 1.1 and 1.2. Based on the type of data collected, this report has 1) detailed
ways to build a 3D model, 2)highlighted particularities of the process (uncertainty of some items and how
to model them), 3) presented ways to make modeling more automatically (using existing software on the
market that speed up the process of 3D modelling based on point clouds), and 4) illustrated how to depict
them in a 3D model by using phases.

The report is addressed to all stakeholders and it offers guidance and assistance to the companies in
creating their own workflows while being aware of some of the challenges (since renovation projects have
always a degree of unknown) that they might face when modelling for a renovation project for residential
projects. The experienced companies in renovation projects can also use this document to refine their

ongoing process.
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APPENDIX 1 - BIM SPEED METHODOLOGY TOOLKIT

The BIM Speed Methodology Toolkit supports you to identify the main renovation geal for your renovation project.
BIM Speed
_. You can differentiste relevant Rencvation Phase and RIBA Stage and identify possibilities of comesponding
MEthDdD'BQ)‘ Toolkit Business Frocess andior BIM Use case, including range of potential methods.

Rev. 2.3 Result is = list of data to be collected and a link to comesponding task of WP1.

o . This list will be specified more detailed during project runtime of BIM Speed project and
HOCHTIEF ViCon in accordance to demo site requirements, elaborated in WPS.
25002020 Firzt impression of WP8 integration can be reviewd in Tab "2, DemoSite”.

Fieaze Note:
i new data iz available, please update comesponding tab [marked with #8£) and update PowerPivot data model.
Filease do not change formatting of this tab.

1. Choose goal to be achived 2. Choose RIBA Stage andlor
( please take care to make a choice for each one, BIM Speed Renovation Phase
"." if goal is not intended)

=
(30 Modding besed on 20 draming=
|30 Mudsding bersed on pickres

(30 Modsing besed on poirt clouds

Business process description i, - BIM use case description = =% Methods description = X
[ ghon obe akded) | A (20 scherkiing 1A = I A
[ Ae-brilt Acoustic C i L | [ Acire: dessic bese infrmaion | |30 Muodsing of exising sset bessed on 20 drewings 1
[ Ae-brilt Envergy i ) | Aememing HVAC irestallasion with rrms 1 [mnﬂiqa-nﬁqmnwmpﬁm 1
[ As-bauit koo Air Sty i L | [ Ao s-bsilt Acoussic Combort | [mnuﬁrqa—nﬁrq 1
[ As-built igon L ]v | Azt axs-built Ik Air Cuslity ]v [ 7 GIS datia from. ]v

Figure 1. Starting page of the BIM SPEED Methodology Toolkit

1. Choose goal to be achived 2. Choose RIBA Stage and/or
( please take care to make a choice for each one, BIM Speed Renovation Phase
choose "-" if goal is not intended) BIM-SPEED Renovation Pha...” T
(- Exdsting buiding Data collection |
[ 2 Renavation Design ]

3. Performance Analysis
"

Business process x
[Assessment: Acoustic Comrort 3D Modeling based on 2D drawings ~
[ Assessment: Asset information. e e e

[ Aecacemant \ieual Frmine Anahmeis

Business process description = % BIM use case description h 4 Methods description e
(A buit Acoustic Comfort assessment (detailed descriptio | ~ [ Acauirs design base information )~ = ] A
[[As-buit Energy perfomance assessment (detailed descrip... | [[Assess existing MEP condition ] [ (30 Modsing of existing assst based on 2D drawings |
[ As-buit indoor Air Quality (detailed ption... | [ ing i gy costs using measured data ) (30 Modeling of existing asset based on pictures ]
[ As-buit Thermal Comfort ipti ) [ ing the eneray of buidings with ) [munﬁunrmmmmmm ]
[ Asset current status of installations (detailed description to ]v (B GIS data integration ]v (2 tion for fing web ]v
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APPENDIX 2 — LIST OF TOOLS FOR 3D MODELING

Software Name | Developer Discipline Native Other types of files Type of
output file License
Architecture, IFC, .nwc, .dwg, .dxf, | Paid license
REVIT Autodesk Structure, vt .dgn, sat, .dwf, .dwfx,
M.E.P. fbx, .gbxml,
IFC, IFCxml, IFCzip, | Paid license
ARCHICAD Graphisoft | Architecture * .pln 3dm, .dwf, .dxf, .dwg,
.dgn,
dwg, .dxf, .dwf, .dwfx, | Paid license
VECTORWORKS | Nemetschek | Architecture VWX sat, .stp, .step, IFC,
[FCXML, .3ds,
Architecture, dwg, .dxf, .fbx, .skp, | Paid license
MICROSTATION Bentley Structure, .dgn step,.3mx
M.E.P.
Architecture, ste, .stp, .step, .igs, Paid license
BRICSCAD BIM Bricsys Structure, dwg iges,
M.E.P.
dxf, .dwg, .dwt, .dxb, | Paid license
ALLPLAN Nemetschek | Architecture .ndw .dgn, IFC, IFCXML,
skp, .3dm, stl, .wrl,
Architecture, IFC, .dwg, .dxf, step, | Free license
FreeCAD Structure, fcstd ply, **
M.E.P.
Architecture, Free license
B-processor A?rhu:c, Structure,
University
M.E.P.

Notes:

* An Add-in from the software company needs to be installed.

** A lot more files can be exported, but only the most common ones where mentioned
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APPENDIX 3 - BIM Roles inside a company

There are 4 different BIM Roles involved inside a project and in an organization (See figure below). The
number of resources depends on the size of the company or project involved. The organigram for each

BIM project is presented in the BEP.

BIM
Coordinator
MEP

BIM modeler
MEP

BIM modeler
MEP

BIM modeler
Structure

BIM
Coordinator
Structure

BIM modeler
Structure

BIM
Coordinator
Architecture

BIM
Coordinator
Architecture

BIM

A brief description of the role description, competency, and role inside an organization for each position

are presented in the following table.

Director/Lead BIM department

- implement and ensure
compliance with the
company’s BIM policies;

- create the framework for

internal collaboration;

BIM Role Role description Role inside the organization | Competency and BIM
experience
BIM Leads the entire - develop BIM policies; - leadership and coaching;

- planning and ability to
persuade;

- the ability to define BIM
outcome;

- capability in 2 or 3 BIM
modelling software

packages;

BIM Manager Responsible for the

implementation,

management, and

- Manage the BIM process by

the necessary tools;

- leadership and coaching;

- planning and organization;

Coordinator
Architecture

-

N\

s
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delivery of BIM on

projects.

- setting up BIM protocol and
BEP;

- Guide a project team and
offer assistance to the wider
practice

- meet and present to the
client BIM related issues

- Continuously review
optimal BIM related software
- Provide BIM training

internally.

- creativity, problem-solving,
collaboration.

- experience in viewing and
coordinating BIM.

- setting up a BEP and a BIM

protocol.

BIM Coordinator

Responsible for
model delivery,
coordinating, and
reviewing. Ensures
the standards are

met.

- checking the models with
objectives and condition;

- ensures compliances with
BEP.

- checking and monitoring
the implementation of
changes in the model;

- promote the use of BIM and

best practices.

- problem analysis,

- planning and organization;
- quality orientation;

- collaboration and creativity.
- the ability to use 2-3 BIM
software;

- experience in BIM
outcomes;

- experience in setting up and

coordinating a BIM project.

BIM Modeler

Responsible for
model delivery and
ensures the model
complies with
project and

company standards.

- add data to the model in a
BIM Environment;

- ensure compliance with
BEP;

- Optimally use of the
software and make
suggestions for developing or

improving software tools

- collaboration;

- creativity;

- quality orientated;

- knowledge of the BIM
process.

- knowledge of BIM

modelling software;

“ SPEED
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